Computer in Everyday Life

(Teacher Manual) Class-1toS5

COMPUTER IN EVERYDAY LIFE CLASS-1
1. Computer and Its Family

A.l.c2.d3.cd.c

B. 1.clectronic 2.tired 3.mistakes 4.memory 5.fast 6.accuracy,calculation 7.time
8.schools, offices.

C. 1. A computer is an electronic device which is designed to work with
information. 2. A computer have 6 parts. 3. CPU is the major part of the computer
system and known as the brain of the computer. 4. We use a keyboard to input data.
5. We can see images, movies and whatever we write or draw, on a computer
monitor. 6. A computer can do calculations, store information, generate electricity
and telephone bills, compose music, etc. 7. Analytical Engine was the first
mechanical computer designed by Charles Babbage. 8. Speed and Accuracy.

2. A Friendly World of Computers

A.1.b2.c3.c4.d
B. Solve sums, write anything, sing, draw pictures and chat.
3. The Keyboard
A.1.b2.d3.c4b
B. 1 keys 2.alphabetic keys 3.0,9 4.Function 5.two 6.two 7.Spacebar key
C. 1.A keyboard looks like a typewriter which contains keys to feed information
into the computer. 2.Keyboard is an input device. 3.There are 2 types of keys on a
keyboard i.e. Letters and Numbers (Alphanumeric), Special keys.Some of them are
function keys, control keys, arrow keys, caps lock key, and so on. 4.Spacebar key
5.26 alphabetic keys 6.10 number keys
4. The Monitor
A.1.b2b3.c
B. 1.monitor 2.brain 3.screen 4.VDU 5.Visual Display Unit 6.output
C.1l.c2.f3.d4.g5.b6.a7.e
D. 1.A monitor is an output device 2.A monitor is used to watch movies, write
anything, feeding information, etc. 3.3 types 4.Output device 5.A monitor can be
used to watch movies like in a television.
S. The Mouse
A.l.a2.c3.bd.c
B. 1.pointer 2.mouse pad 3.two,three 4. monitor 5.input
C. 1. Amouse is an input device which is connected to the CPU. 2.A mouse is used
to move pointer,draw pictures,select any item and play games on the computer
monitor. 3.two or three 4.3 types.Based on technology and working principle, there
are 3 types of computer mouse-ball mouse,optical(LED)mouse and laser mouse



5.Amouse s an input device as it is used to feed the information in computer.

6. Compact Disc
A.1.b2.d3.d4.c

B. l.video,text2.1GB 3.Compact Disc 4.optical 5.DVD

C. 1.A Compact Disc is small ------- information in digital form. 2.We use a
Compact Disc for recording, storing and playing audio, text and other information
in digital form. 3.Capacity of common size CD is 700 MB 4.Compact Disc(CD)
5.Digital Versatile Disc(DVD)

D. 1.Compact Disc 2.speakers 3.keyboard 4.mouse 5.pen drive

7. Drawing and Painting in Computer

A.1.b2.b3.b

B. 1.leftside 2.Free-Form Select 3.scanned 4.pencil 5.drawing

C. 1.MS Paint program is a drawing tool used to create simple or elaborate
drawings. 2.Print the drawings, view and edit the scanned photos, apply colours to
the drawings, etc. 3.We can see the drawing area in the center of MS Paint window.
4.Eraser tool is used to erase a part of drawing. 5.Pencil tool is used to make free
hand drawings. 6.Free-Form Select Tool, Pencil Tool, Color Tool, Brush Tool.

8. Storage in a Computer

A.l.c2.d3.b4.d
B. 1.almirah 2.school bag 3.stored 4.eatables, school 5.refrigerator, vegetable

C. 1.The area in which we can store our important things is called storage. 2.We can
use the stored data from the storage whenever we need it. 3.HDD(Hard Disk Drive)
is anon-volatile data storage device, used to store and retrieve digital data from the
planar magnetic surface.

COMPUTER IN EVERYDAY LIFE CLASS-2
1.Computer in the World

A.1.c2.b3.d4.b

B. l.device 2.available 3.user 4.diagnose S5.millions 6.calculation
7.reservation,flights
C.1.T2.T3.T4F5F6.F7F8.T
D. 1.Response 2.Colleges 3.Banks 4.Schools 5.Railways and Airports 6.Hospitals
E. 1.We find computers in many places such as in schools, colleges, shops, banks,
hospitals, etc. 2.Do yourself 3.In teaching aids, office works, to study and learn, etc.
4.4 types. 5.Computer is a very fast device, accuracy of calculation is very high,
draw and print graphics and converse with users through an input/output device.
6.A computer is an electronic machine which takes input data, process it and gives
the desired output.

2. Types of Computers

A.1.d2.d3.d4.d



B. 1.portable 2.Personal 3.microprocessor, microcomputer 4. Tablets
C.1.F2.T3.T4T5F

D. 1.4 types 2.A computer with a microprocessor and a central processing
unit(CPU) is known as a microcomputer. 3.Personal computers are the computers
which can fit on desks or tables and are the best choice for the single-user tasks.
4.The laptop computers are the lightweight computers with a thin screen. 5.A
palmtop computer gets power from a battery.

E. Desktop computers are easier to use and more affordable. Desktop computers
are widely popular for daily use at the workplace and in the households.

3. Parts of a Computer

A.1.d2.b3.c4.d

B. 1.television 2.Processing 3.output 4.keys 5.Uninterrupted, Supply 6.CPU 7.a
wire

C.1.T2.T3.F4F5T6.F7.T8.T

D. 1.Monitor, CPU, Keyboard, UPS 2.A mouse is an animal which can run, eat, has
atail and lives in the hole while, computer mouse is a machine that can't run, eat and
doesn't have tail like a mouse. 3.UPS keeps the computer running for several
minutes after a power outage. 4. Numeric Keys, Alphabet Keys, Function Keys,
Scroll Key, Caps Lock Key, Spacebar Key(longest key), etc. 5.Speakers are used to
play sound. They allow us to listen to music and hear sound effects from a
computer.

E.1.b2.a3.d4.c

4. Input and Output Devices

A.1.d2.b3.b4b

B. 1.keyboard 2.scanner, computer 3.output 4.instrument S.printout 6.CRT
(Cathode Ray Tube), LCD(Liquid Crystal Display)

C.1.F2.T3.T4T5T6.F

D. 1.The device which shows us the information or result is called an output device.
2.Monitor, Printer 3.Keyboard, Mouse, Scanner 4.A scanner is an optical device
that reads a printed page and converts into a graphic image for the computer. 5.A
printer is used to get a printed copy of the information, make reports, projects,
photos, greeting cards, etc. 6.CRT(Cathode Ray Tube), LCD(Liquid Crystal
Display) 7.A microphone is an instrument used to put sound into a computer. It
needs a sound recording software.

5. Special keys of the Keyboard

A.1.b2.d3.a4b
B. 1.typewriter 2.window 3.Delete 4.Spacebar 5.cursor control 6. Tab
C.1.T2.F3.T4T5F6.T

D. 1.Longest Key 2.Refreshes the current window 3.0pen Windows Help 4.A
document to the line below 5.A document one character to the right 6.Used to go to
the next line 7.Erases the immediate character left of the cursor 8.Control Key
9.Used to move forward 10.Typewriter



E. 1.A keyboard looks like a typewriter which contains keys to feed information
into the computer. 2. There are 4 types of keys on the keyboard. 3.Spacebar Key 4.
Without a keyboard, we can't do most of the works on the computer. 5.The Shift
Key has to be pressed every time(along with character key) we need to write
character in capital letter while, the Caps Lock Key is pressed once if we need to
write only in capital letters. 6.The cursor shows that the computer is ready to work.
7.The Tab Key is used to move forward through options in a dialog box. 8. The Enter
Key isused to go to the next line or to get the result.

6. Draw and Colour Shapes

A.1.d2.a3.c

B. 1.Text tool 2.Color box 3.Polygon tool 4.Rounded Rectangle Tool 5.4 types of
tools 6.Air Brush Tool

C.1.T2.F3.T4.F
7. Knowing Windows

A.1.b2.c3.b4d

B. 1.easier 2.program 3.selected 4.box, frame 5.internet 6.Title bar 7.paint, music
8.popular, computer

C. 1.The top of the screen 2.The bottom of the screen 3.Dustbin 4.Small pictures on
the desktop 5.Close the title bar 6.Minimize the title bar 7.Active 8.Maximize the
title bar 9.Not active 10.Opens the selected icon

D.1.T2T3. F4TS5F6T7F8.T

E. 1.When we switch on a computer, a screen is displayed called Windows
Desktop. 2.The topmost bar of an application window. 3.Move the mouse pointer to
the My Computer icon. Double-Click on the left mouse button. 4.Clicking the left
mouse button 2 times. 5.When we click on any item on the screen, it gets selected.
6.The blue title bar indicates that it is active. 7.1t means that Title bar is not active.
8.Anicon is a small picture that we see on the desktop. 9.Click on the middle button.
The window will become smaller in size. Again, on clicking the same, the window
will come back to its normal size. 10.Windows 98, Windows 2000, Windows XP.

8. Calculator and Computer

A.l.c2.d3b

B. 1. keyboard, mathematical symbols 2. single 3. numeric 4. not store 5. many 6.
battery or cells.

C.1.T2F3.F4F5F6.T

D. 1.Both Calculator and Computer have a keyboard and mathematical symbols.
Both can generate results with high speed and accuracy. Both can process numeric
information. 2.A computer can draw pictures which a calculator can't. A computer
can process non-numeric instructions which a calculator can't. A computer has a
large screen as compared to a calculator. 3.No 4.Numeric information 5.A
computer can process numeric and non-numeric information.

9. Internet and Multimedia

A.1.d2.b3.cd.c



B. 1.connection, computers 2.Multimedia 3.programs 4.boundaries 5.internet

C. 1.Internet is a global network of millions of computers interconnected with each
other. 2.Multimedia is the presentation of information through more than one
presentation medium of the combination of text, sound, pictures, animation and
video. 3.Entertainment, Education, Marketing and Advertising 4. We use internet to
search anything and everything, for shopping, to keep in touch with our friends and
relatives and to send the e-mails(electronic mails). 5.An e-mail is a electronic mail
by which we can directly talk and chat with our friends and relatives.

D. An internet is a global network connecting millions of computers. It is made up
of two words: inter means 'between' and net means 'connection'. When two or more
computers are connected, it is called a network. Using an internet, we can share
data, information, programs and messages as well.

E. We use different mediums to share any information with others. These mediums
can be text, sound, pictures, animation, and video. Making use of these modes of
communication is called Multimedia.

10. Precautions
A.1.d2.b3.d4.d
B. 1.shoes 2. teacher 3. carefully 4. should not 5. clean
C.1.F2F3.T4T5F6.T

D. 1.We should not eat or drink. We should not wear shoes in the computer room.
Keep the computer room clean and its door closed. 2.We should not press any
power switch when the computer is ON. We should not press any key of the
keyboard without knowing its function. Cover the computer after completing the
work. 3.Do yourself 4.because the dust carried by shoes can be harmful for your
computer system.

COMPUTER IN EVERYDAY LIFE CLASS-3
1. More About Computers

A.1.d2.c3.d4.a5b

B. 1.control 2.brain, intelligence 3.Central Processing Unit 4.decisions 5.personal
6.Cray XMP-24 7.ICL-39 series, CDC Cyber series 8.CPU 9.5 10.Arithmetical,
CuU

C.1.T2F3F4T5F6.T7.T8T9.T10.F

D. 1.Speed, Accuracy, Storage, Diligence, Versatility 2.Microcomputers,
Workstations, Minicomputers, Mainframe Computers and Supercomputers
3.Analog, Digital and Hybrid. 4. A computer has no brain or intelligence of its own.
It has no common sense. It only performs operations as instructed by the user and
can't learn with experience. 5.Computers can do calculation rapidly and accurately.
It can store large amount of data and information and can draw, print graphics etc.
6.CPU is used to execute the instruction for processing. 7. (a) Mainframe
Computers are the computers with smaller size and capacity as compared to the
Supercomputers. (b) Microcomputers are smaller in size and cheaper as compared

to Minicomputers.



2. Computer Memory

A.l.c2.d3.b4.c5b

B. 1.80, 18 2.1 Megabyte(MB) 3. temporarily 4.myler plastic or very smooth metal
coated with magnetic ferric oxide on both sides. 5.storage, data 6.1.44 MB 7.tape
8.laser 9.1024 MB 10.Gigabyte

C.1.T2F3.F4T5T6.T7.F8F9.T10.T

D. 1.The space which keeps the data and instructions retained in the computer is
called memory. 2.Primary memory is the main memory which is required in a
system and temporarily open books or copies, files, etc. to work upon. 3.Secondary
memory is also called auxiliary memory, which stores data permanently. 4. RAM is
a volatile memory and ROM is a non-volatile memory. 5.There are 4 types of
secondary storage devices. 6.CD stores data using the principle of magnetism. The
laser technology is used to write data on the disks. 7.A hard disk is a circular platter
made up of mylar plastic or very smooth metal coated with magnetic ferric oxide on
both sides. 8.Byte, Kilobyte(KB), Megabyte(MB), Gigabyte(GB), Terabyte 9.A
pendrive is another name for a USB flash drive. 10.USB stands for Universal Serial
Bus which allows the storage of computer files to remove and take from computer
to computer.

3. Working with Windows XP

A.l.a2.b3.c

B. 1.Icons 2.desktop 3.task bar 4.start button 5.single 6.Dragging 7.Control
C.1.T2.F3.F4TS5.T

D. 1.Normal 2.Double Head Arrow 3.Busy 4.Four Head Arrow

E. 1.Windows XP is an operating system over which approximately 90% of
personal computers run. 2. The first screen that appears with labelled pictures on it,
is called Desktop. 3.Taskbar is the long horizontal bar at the bottom of the desktop.
4.The start button is used to quickly access the programs, documents, Windows
applications, and much more. 5.With the help of mouse, we can select/deselect the
icons, move and organise the desktop icons, etc. 6.Icons are the labelled pictures on
the screen. 7.We can move the icons by dragging using a mouse. 8.The Screen
Saver is an image, which pops-up on the computer screen whenever the computer
remains idle for a short time. 9.Right-click on blank part of the desktop ----- Click
on OK button. 10.Right-click anywhere on the desktop ----- Click on OK button.
11.My Computer, My Documents, Recycle Bin, My Network Places. 12.0pen
Date/Time properties in Control Panel ----- click the spinner arrows.

4. Hardware and Software

A.1.d2.b3.c4.d

B. 1.software 2.joystick 3.light pen 4.output devices 5.software 6.system software
7.joystick

C.1.T2.F3.F4T5F

D. 1 joystick 2.microphone 3.scanner 4.light pen 5.speakers

E. 1.Keyboard 2.85+90+69+98+76+84 3.Printer 4.Input and output devices

5.Songs and movies



F. 1.Software is a set of instructions or program that tells the hardware what to do
and how to do. System software and Application software. 2.System software
3.Part of the computer which we can touch and see is called hardware and the part of
the computer which we can't touch but see is called software. 4.Application
software is a software which is used to do a specific type of work. 5.Program is a set
of instructions given to the computer.

5. Putting Data in a Computer

A.l.c2.b3.d4.c5.b

B. 1.small 2.keyboard 3.104, 110 4.optomechanical 5.QWERTY 6.0-9 7.Enter
8.Shift9.left 10.Spacebar

C. The keyboard is an input device. It looks like a typewriter. It is used to type or
enter data in the computer. It is made up of different types of keys including shortcut
keys.

D. The mouse is an input device that is very small in size. It slides on a smooth
surface. Itis used as a pointing device to give commands to the computer.

E. 1.The mouse is an input device that is very small in size, used to give commands
to the computer without writing the instructions on keyboard. It is used to
select/deselect icons. 2.Spacebar Key 3.We use a scanner to input paper documents
----- like TIFF, GIF or JPG format. 4.(a)Mechanical Mouse: It has a rubber or metal
ball on its underside which can roll in any direction. Sensor inside them detects the
direction. (b)Optical Mouse: The beam of light emits from it, which activates the
mouse to offer it direction and speed. (c)Optomechanical Mouse: It is the
combination of the optical and the mechanical technologies. 5.(a)Alphabetic Keys:
They are used to type letters (A to Z). (b)Functional Keys: They are at the top of the
keyboard labelled F1 to F12 and carry different functions for different software.
(c)AltKey: Akeyboard has two alt keys, used for activating program menu options.
(d)Spacebar Key: It is used to give space between two words, letters or number.
(e)Shift and Caps Lock key: The Shift key allows the user to type a single capital
letter and the Caps Lock key is pressed once to write all the letters in capital. 6.Keep
the left button pressed and drag the mouse to move the object to the place where you
want to place it. 7.(a)Ctrl Keys: They are used for issuing some special control
instructions to the computer. (b)Esc Key: It is used to cancel or ignore the command
that we have entered. 8.The arrow keys are the 4 keys which are used to move the
cursor in any of'the four directions on the screen.

6. Managing Files and Folders

A.1.b2.a3.d4.b5.c
B. .collection, images, movies 2.save 3.copy 4.Shift+Delete 5.F2 6.shortcut
C.1.F2.T3.F4TS5F

D. 1.a folder within a folder 2.common way to create a file 3.File menu 4.Paste tool
5.Cuttool

E. 1.All the relevant files are kept in a file cabinet called folder. 2.The collection of
records, images, documents, etc. is called a file. 3.A folder can contain files, folders
and sub-folders but a file contains collection of records, images, documents, etc.
4.A shortcut is an icon that provides an easy and quick way to open a file/program.

ot



5.0pen MS-Word and start typing text on the blank page. Save it using Save option
from File menu and type a file name in the dialog box. 6.We can save a file at any
location by using Save option from File menu. 7.Select the file and press
Ctrl+X/use the Cut tool from the Edit menu to remove it from current location.
Open the folder where it is to be moved. Press Ctrl+V/use the Paste tool from Edit
menu. The fileis moved.

7. Word Processor 2010

A.l1.c2.d3.a4.b

B. 1.Title bar 2.powerful, tools 3.View Tab 4.Quick Access 5.Mailing Tab 6.Create
anew page 7.Save

C. 1.bold text 2.to delete text from left side 3.to add new words 4.to bring the cursor
tonext line 5.to delete text from right side 6.to start a program 7.Open file

D. 1.MS-Word is a word processing program, designed to create professional-
quality documents. 2.MS-Word is used to organize and write documents more
efficiently. It provides powerful editing and revising tools to collaborate with others
easily. 3.In MS-Word, we open a File by pressing Ctrl+O or by using the Open tool
from the File menu. 4.Click the File tab and then click New. Under Available
Templates, click on Blank Document and Click Create. 5.The Format Painter is a
MS-Word feature which allows us to copy a format applied to text already in the
document. 6.By clicking a single button called Change Case on the ribbon. 7.The
Quick Access Toolbar displays a small selection of the more commonly used
commands in Word 2010. 8.Undo command is used to remove the last thing we did
inadocument and the Redo command is used to redo the last action.

8. More About MS-Paint

A.l.c2.d3.d4.a

B. l.circle 2.Pencil, free-form 3.colours 4.16 5.Magnifier tool 6.erase 7.paint
8.Rectangle

C. 1.Click the Ellipse tool in the toolbox and drag the pointer diagonally. By
holding down the Shift key we draw a perfect circle. 2.Click the Rectangle tool and
hold down the Shift key while dragging the pointer to draw a square. 3.To fill pink
colour in a square, click the Fill With Color tool and the area to fill. 4. Text tool

9. Internet and its Applications

A.l.a2.c3.c4.c

B. l.everyday 2.e-mail, audio 3.collection, devices 4.Domain 5.File Transfer
Protocol 6.World Wide Web 7.Chat 8.internet

C.1.T2F3.T4TS5F6.F7.T

D. 1.logging on 2.username 3.Internet Explorer 4.web pages/websites 5.Home
Page 6.navigate 7.e-mail

E. 1.Internet is a collection-------- or mesh technologies. 2.0nline shopping, Net
banking, Communication, Job search, etc. 3.The requirements are Computer,
Modem, Web browser, Telephone line and ISP. 4. Type www.google.co.in and at the
top right corner click on Sign In option ----- finally, click on I accept. Account is
created. 5.Trash consists of a list of mails deleted and Spam mails are unsolicited




junk e-mails sent by commercial companies for advertising. 6.0Online shopping,
Net banking, Communication, Research, etc. 7.FTP is a standard network protocol
used to exchange and manipulate files over the internet. . WWW is a way of
accessing information over the medium of the internet.

COMPUTER IN EVERYDAY LIFE CLASS-4
1. Computer History and Development
A.1b2.a3.d4.a5d

B. 1.5000 2.multipurpose 3.Analytical Engine 4. ENIAC 5.second 6.vacuum tube
7.supercomputers, Cray XMP-24 8 Hybrid

C.1.F2T3T4F5T6.F71.T
D.1.f2.e3.d4.g5b6.a7.c
E.Do Yourself

F. 1.Computer is a device or a flexible machine to process data and converts it into
useful information. 2. Abacus is a wooden rock holding two horizontal wires with
beads strung on them. When these beads are move around, all regular arithmetic
problems can be done. 3.A scientist from England, Charles Babbage invented a
machine which could keep our data safely, called the Analytical Engine 4. ENIAC
5.In the first generation computer, the concept of vacuum tubes was used and in
second generation, the concept of transistors was used. 6.Do yourself 7.Digital
computers manipulate most data more easily than analog computers as it works on
digital information rather than analog information.

2. Input, Output and Storage Devices
A.1.d2.b3.c4.a5d

B. 1.peripherals 2.buttons 3.touch 4.barcode, thicknesses 5.kiosks, ATMs 6.VDU
7.Liquid Crystal Display 8.digital 9.Computer Aided Design 10.Cathode Ray Tube

C.1.F2T3.F4T5F6.F7.T8T9.T10.T
D.1j2.i3.f4.a5.2g6.h7.d8.c9.b10.e
E. Do Yourself

F. 1.The devices that send data to the computer are called input devices. 2.The
devices that receives output from a computer are called output devices. 3.A
keyboard is a text base input device and a mouse is a small device used to pointto a
particular place on the screen. 4.2 or 3 types 5.Computer monitor is an output
device that resembles the television screen and uses a Cathode Ray Tube(CRT) to
display information. 6.2 types, Impact and Non-impact printers. 7.(a)Primary
memory is a volatile memory and Secondary memory is a non-volatile memory.
(b)In RAM, information is accessed randomly and in ROM, information is
hardwired and can't be erased. (¢)Hard disk is a large, circular platter made up of
Mylar plastic and Pen drive is a small, removable storage device.

3. Computer Software

A.1.d2.c3.b4.c
B. 1.Hardware 2.physical 3.computer 4.System 5.master 6.programming

<D



7.interpreter 8. Application 9.Database 10.Media Player
C.1.F2.T3.T4F5F6.T7F8F9.T10.T
D.1.g2.f3.a4.b5.h6.c7.e8.d

E. 1.Computer Software is a collection of computer programs. 2.Hardware is a
physical part and Software is a logical part. 3.Three 4.1t is a master control program
that runs the computer by controlling all of its components and acts as a scheduler.
Unix, Linux and Windows XP 5.Programming Language is used in the
communication of computer instructions and Operating System is a master control
program that runs the computer. 6. Assembler is a language translator for a low level
programming language and Interpreter translates and executes each program
statement one at a time. 7.Application Software is a software, written in high level
language, which is able to manipulate text, numbers and graphics. 8.Media Player
isused for viewing movies and listening to music and songs.

4. More on Windows

A.1.d2.d3.b4.a

B. 1.Windows 2.control panel 3.background 4.background, icons, Windows,
mouse pointers and sound etc. 5.High Resolution 6.Windows 7.welcome screen,
start menu 8.users

C.1.F2T3T4F5T6.T7.T8F
D.1.d2.a3.f4.c5bb6.e

E. 1.Control Panel is a powerful tool, used to install new hardware, add and remove
programs, change the look of your screen, etc. 2.Theme is a set of visual elements
that provide a unified look for the computer desktop. 3. Wallpaper is the background
displayed on the desktop. It can be personalized. 4.Mouse is an input device that is
small in size. It is used to select/deselect an icon on the computer screen. 5.User
Account defines the actions that the user can perform in Windows. It includes
username and password required for the user to log on, groups, rights and
permissions, etc.

F. 1.Windows is an operating system by Microsoft. 2.Control Panel is a powerful
tool, used to install new hardware, add and remove programs, change the look of
your screen, etc. 3.Click on the Add New Programs icon on the window and then
specify the location from where the new program is to be installed by clicking on.
4.Click on the Add/Remove Windows Components icon on the window ----- Click
on the option you want to select and install. 5.Right click on the desktop and choose
Properties. On the desktop tab, click the desired picture in the Background list.
Click on Apply and then OK. 6.Screen Saver is a moving picture or pattern that
appears on computer screen when we have not used the mouse or keyboard for a
specified time. Open Display in the Control Panel and click on the Screen Saver tab.
Choose the desired Screen Saver in the list. Click on Apply and then OK.
7.Appearence of Windows elements means their look and feel, style, size, color,
effect, etc. 8.User Account defines the actions that the user can perform in
Windows. It includes username and password required for the user to log on,
groups, rights and permissions, etc. 9.0pen User Accounts in the Control Panel -----
Click Create Account. 10.0pen User Accounts in the Control Panel. Click your



account name and then Click Change my picture. 11.Do yourself.
5. Desktop and Start Menu

A.1.d2.c3.a4.b

B. 1.colours, Active Window 2.desktop 3.right clicking 4.explore 5.date, hide
6.restart, Shut down

C.1.F2T3.T4F5T6.T

D. 1.Right click the mouse in blank area of desktop. Select Properties from the
menu-----Click Apply to see the change or Click to accept the change. 2.Do
yourself 3. Right click the mouse in blank area of desktop. Click on Properties and
then Desktop tab.....Click Apply to see the changes or Click OK to accept the
changes. 4. Right click the mouse in blank area of desktop. Point to Arrange Icons
By to sort the items by Name. 5.Right click on an Icon and then click on Rename
option to rename the Icon. 6.Right click on the taskbar, select the Properties option
—————— Select the show the Clock check box. Click Apply and then OK.. 7. Right click
the Taskbar. Select Properties from the menu-----Click Apply to see the change or
Click to accept the change. 8.Right click on the taskbar and click the Properties
option. Now, Click the Taskbar tab and check the desired option to show it on the
top. Click Apply and then Ok.

6. Creating Documents in MS-Word 2010

A.l.c2.d3.b4.c

B. 1.Microsoft Word 2.File, Save 3.Paste 4.graphics 5.convenient 6.page break
7.WordArt 8.Word Wrap 9.MS-Word 10.Zoom

C.1.T2.F3.F4T5T6.T7.F
D.1.c2.d3.e4.f5h6.g7.b8.a

E. 1.Microsoft Word is basically used for word processing. 2.Click the File tab.
Click Save As option. Type name and then click Save. 3.Spacing between two lines
in a document is called Line Spacing. To change the Line Spacing, apply a Quick
Style set. 4.A document theme gives a professional look to the document. 5.0n the
Insert tab, in the Tables group, click Table. Select no. of columns and rows.
6.(a)Used to select all. (b)Used to copy the text. (c)Used to make the text bold.
(d)Used to Justify. (e)Used to print document. 7.Left click the mouse and drag to
select any text. 8. Word Wrap is a part of formatting pictures and WordArt is used to
add special text effects. 9.0n the Insert tab, in illustrations group, Click SmartArt
and select desired SmartArt graphic and click OK. 10.Highlight the text and click
New Comment under the Comments group.

7. Introduction to MS-PowerPoint 2010

A.1b2.c3.c4.d

B. 1.theme 2.create, photographs 3.Tables, Charts 4.Slide 5.Slide 6.animations,
slide 7.Animation Pane 8.F5

C.1.T2F3.T4T5F6.F7F8.T

D. 1.Powerpoint is a presentation graphics software developed by Microsoft.
2.Used to create, view and present slide shows that combine text, shapes, pictures,
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animations, etc. 3.A slide is a page of PowerPoint presentation. 4.New Slide
command on Home tab. 5.Click on the Insert tab and then on the Photo Album
command-----slideshow will be created. 6.Slide transition is all about moving from
one slide to another in a slide show and the effects during transition are called
Animations. 7.The animation that is customized by user. 8.Slide transition controls
how the presentation goes and Custom Animation create animated effects during a
slide show 9.Select the slide which -------- on the Preview command. 10.To save
your slides --------- or SaveAs.

8. Logo Commands

A.l.c2.b3.b4a

B. 1.LOGO 2.Home 3.HideTurtle 4.PENDOWN 5.PENERASE 6.PRINT
7.PRINT

C.1.F2.T3.T4F5T6.F7F8F9.F10.T
D. 1.PenUp 2.PenErase 3.PenDown 4.Forward 5.Backward 6.Home 7.Hide Turtle

E. 1.The commands used to draw continuous drawings with the help of triangle
shaped turtle that moves on computer screen are called LOGO commands. 2.PU,
PE, PD, Repeat 3.PD puts the turtle's pen back on the screen and PE command
erases the lines drawn by the turtle's pen. 4. REPEAT command is used for doing the
repetitive actions like to make a drawing. 5.REPEAT 360[FDRT1]-------- more
smaller circle. 6.PRINT MATHEMATICAL EXPRESSION, PRINT[TEXT
EXPRESSION] 7.PRINT command is used to print text messages and to do simple
calculations like addition, subtraction, multiplication and division using LOGO.
8.Do Yourself

9. More on Internet Searching

A.1b2.d3.a4.c

B. 1l.superhighway 2.Millions 3.World Wide Web 4.Uniform Resource Locator
5.software programs 6.browser 7.search engine

C.1.T2T3.F4F5F6.T7F

D. 1.Internet is the international network of millions of computers interconnected
with each other to share the information. It is used for searching and data on any
topic, chatting, instant messaging, video calling and conferencing, etc. 2. Very first
web page that we see on opening a website is called a Home Page. 3.URL is a
formatted text string -------- resources on the internet while Hyperlink takes the
reader quickly to other parts of the same web page or to other web pages. 4.A
software program that allows us to search for and view various information on the
web. Microsoft Internet Explorer, Opera, Mozilla's Firefox and Mac Safari. 5.Click
the Internet Explorer -------- on the browser.

COMPUTER IN EVERYDAY LIFE CLASS-5
1. Introduction to Computers

A.l.c2.d3.d4.c5d

B. 1.Computers, accuracy 2.accuracy 3.versatile 4.dumb 5.second 6.nanoseconds
7.VLSI, small 8.magnetic, large 9.portable 10.Artificial Intelligence (AI)
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C.1.T2T3.F4T5T6.T7.T8FI9.F10.T

D. l.Integrated Circuit 2.Large Scale Integration 3.Very Large Scale Integration
4.Graphical User Interface 5.Personal Computer 6.Electronic Numerical Integrator
And Calculator 7.Universal Automatic Computer 8.Electronic Discrete Variable
Automatic Computer 9.Expert System 10.Natural Language Processing

E. 1.UNIVAC, ENIAC, EDVAC 2.PDP-8, IBM 1401, CDC 1604 3.IBM 370, PDP
11 4.INTEL 4004 chip 5.Intel dual-core microprocessor

F. 1.Computer used for the --------- fashion industry, etc. 2.Speed, Accuracy,
Diligence, Versatility, Storage Capability, etc. 3.1t is a dumb machine as it can't do
any work without instructions from the user. 4.Do yourself 5.(a)First generation of
computers used the Vacuum tubes, while Third generation used the ICs. (b)Second
generation of computers used the Transistors, while Fourth generation used the
Microprocessors. (¢)First generation of computers used the Vacuum tubes, while
Fifth generation used the Artificial Intelligence (AI) 6.Multiple transistors are
placed onasilicon chip, called IC. 7.Do yourself

2. Software and Its Types

A.l.c2.d3.a4.c

B. 1.Software 2.Hardware 3.system 4.program 5.System, Application 6.System
software 7. Application 8. Application 9.application 10.application

C.1.T2F3.T4T5F6.T7.F8.T

D. 1.The set of instructions used to perform particular task is called software. 2.3
types 3.Computer software provides the instructions for telling the computer what
to do and how to do it. 4.The system software is installed during the installation of
the operating system, while the application software utilizes the capabilities of the
computer on which it is installed. 5.1t includes tools in the form of programs or
applications that software developers use to create, debug, maintain, etc. 6.1t is
designed to perform a specific task and also called custom software.

3. More on Windows XP

A.1.d2.c3.d4.d

B. l.operating 2.Windows 3.Icons 4.application, screen S5.left-hand 6.My
Computer 7.log off 8.Calculator

C.1.F2.T3.F4T5T6.T7.T8.F
D. 1.Moveto Recycling 2.Delete 3.Cut 4.Quit 5.Reboot/Restart

E. 1.Desktop, Icon, Window, Dialog Box, Start Menu, etc. 2.When we log in to
computer, the first screen that we see is called Desktop. 3.At the very bottom of the
screen is a horizontal bar called the taskbar. 4.(a)Maximize makes the active
Window to cover the entire screen, while Minimize makes the active Window a bar
at the bottom of the screen. (b)Resize means to resize the application window if it is
not maximized, while Close means to close and exit from the running application.
(c)Shut down means to turn off the computer, while Stand by mode is used to save
energy when a computer is left alone for a while. (d)Start Menu gives access to all
the different parts and functions of the computer, while taskbar contains start
button, shortcuts to various programs, etc. 5.To open an application, Open the Start

137



menu and click on the name of the application-----choose Open and To close an
application, choose File menu ------ the application's window. 6.Right click on the
file. Click on the Delete option from the menu. 7. Click Start button on taskbar and
then go to All Programs. Now, go to Accessories and then click Calculator from
menu.

4. Virus and Antivirus

A.1b2.d3.c4.d

B. 1.stealth 2.System Infectors 3.boot sector 4.malicious 5.Antivirus 6.periodically
7.virus 8.remedies

C.1.T2F3.T4T5T6.F7.T

D. 1.Virus is a computer program which can copy itself and infect a computer
without prior permission or knowledge of the user. 2.A virus spread from one
computer to another when its “host” program is taken to the uninfected computer
----- or a USB drive. 3.Virus may be programmed to damage the computer by
damaging other programs, deleting files, or reformatting the hard disk, etc. 4. Three
main types: File Virus, Boot Sector and Stealth Virus. 5.Antivirus is a computer
program that detects, prevents and takes action to disarm/remove malicious
software programs. Antivirus software scans file --------- indicate an infection.
6.Antivirus software is used to prevent, detect and remove malware. 7.A virus can
benefit the spreader of the virus/programmer who use it, while an antivirus is
beneficial to the people who get infected by the virus.

5. Algorithms and Flowcharts

A.l.a2.c3.c4d
B. 1.program 2.Algorithm 3.flowchart 4. Flowchart 5.boxes, arrows 6.Input/Output
C.1.T2.F3.T4T5F6.F7.T

D. 1.Start and stop box 2.Input and output box 3.Processing box 4.Decision box
5.Connector 6.Flow lines

E. 1.Algorithm is a step by step procedure, written in simple language, for solving a
given problem. For example, an algorithm to find the sum of: 29,25,7,6 and 18.
2.Graphical representation of a program is called Flowchart. 3. Decision box: used
to make decision, Terminal box: used to start/stop, Processing box: used to indicate
calculations done in a flowchart, Flow Lines: used to show the control of flow of a
program, etc. 4.Do yourself 5.Do yourself 6.Step by step procedure to solve a
problem is called Algorithm, while the graphical representation of the same is
called Flowchart. 7.Input/Output box is used to accept data and print the result.
8.Processing box is used to indicate calculations done in a flowchart. 9.Decision
box is used to make decisions. 10.Directional Arrows, connecting the boxes in a
flowchart, are used to indicate the control of flow of a program.

6. Procedure in Logo

A.1.d2.b3.a4.d

B. 1.Immediate Mode, Procedure 2.procedure 3.commands 4. TITLE 5.BODY
6.END 7.<F2> 8.Sub Procedure 9.Super Procedure 10.Procedure 11.procedure
12.LOGO PRIMITIVE MAKE 13.PARAMETER 14.Recursion



C.1F2F3.T4F5F6.T7.T8F9.T10.F

D. 1.Procedure is a particular way to write a set of primitives to draw any shape on
the screen. A set of title line -------- called a procedure. 2. TITLE: name of the
procedure is written, BODY: combined set of commands/primitives and END: last
part of the procedure. 3.Sign like ' appears. 4.F2 key 5.Procedure used in a
procedure is called Sub Procedure and the Procedure which calls the sub-
procedures is called Super Procedure. 6. Advantages: Makes program simpler one
by breaking it into smaller parts, reduces the possibility of errors, etc. 7.A place
where we can store values and call them for use is called Variable. 8.The value
stored in Global Variable can be used by any procedure, while the value stored in
Local Variable can be used only in the procedure in which it is defined. 9.When a
procedure calls up itself, is called Recursion. For example, drawing a square. 10.
Used to execute a LOGO command on conditional basis. 11. It is used to stop the
procedure with a condition. 12. Itis used to enter a sequence of characters as input.

7. Word Processing MS-Word 2010

A.1.d2.c3.b4.d

B. 1.Formatting 2.characters 3.Underline 4.four 5.multi-column 6.red 7.Grammar
8.F7, spelling

C.1.F2.T3.T4T5F6.F7.F8.T

D. 1.Ctrl+B 2.Ctrl+1 3.Ctrl+U 4.Ctrl+] 5.Ctrl+R 6.Ctrl+L 7.Ctrl+F 8.Ctrl+H

E. 1.Changing the appearance of a document is called formatting. 2.A font is a set of
characters(text) represented in a single typeface. Each character within a font -------
- same basic style. 3.Select the text. Choose the Home tab. In the Font group,
change the size using Font Size box. 4.Select the text and then click on the Format
Painter in Home tab. Now, select the target text by dragging. On releasing mouse
button, format is applied. 5.0n the Home tab, in the Paragraph group, click Line
spacing and click the desired number of line spaces. 6.Left, Right, Center and
Justify. 7.Select the text. Click on Page Layout and go to Page Borders
option....finally, click on OK. 8.Choose the Review tab. Click the Spelling and
Grammar button which displays a dialog box.. .click change.

8. MS-Excel 2010

A.l.c2.c3.d4b

B. 1.tabular 2.intersection 3.formatting 4.chart 5.Hyperlink 6.Sheet Protection
C.1.T2.F3.F4F5T6.F71.T

D.1.d2.f3.e4.a5.b6.c

E. 1.Spreadsheet is a tabular representation ----------- rows and columns. 2.Rows:
1,048,576 and Columns: 16,384 3.Click on MS Office button and choose Open.
Open dialog box is displayed. Select the file and click Open. 4.Each workbook
contains 17,17,98,69,184 cells. 5.0n the Home tab, in the Cells group, Click the
Insert button down arrow and then click Insert Sheet Rows/Columns. 6.Select the
cell(s), click Home tab>, Alignment Group> Merge & Center. 7.Protect Sheet is a
dialog box to prevent changes to cells, graphic objects and the definitions of
scenarios on a worksheet. Using the Protection option.
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9. More on MS-PowerPoint 2010

A.1.d2.b3.c4.d
B. 1 slides 2.Screen Capturing 3.slide, powerful 4. WordArt 5.slides 6.Slide Sorter
C.1.F2.T3.T4T5F

D. 1.Powerpoint is a powerful communication tool used to present our views and
ideas effectively through visual aids. 2.Used in business world and in schools to
teach different topics. 3.Slide is like a page of a presentation that displays a brief
topic. 4.Home tab>Slides Group>New Slide 5.Transition tabs>Transition to this
slide....Click on Apply to All to apply. 6. A slide show is an on-screen presentation
of information / ideas presented on slides. It is just like the pictures in a photo
album. 7. Two ways to run a presentation are Manual and Automatic.

10. Introduction to Multimedia

A.l.c2.a3.b4b

B. 1.Sound 2.presentation 3.Presentation 4.engineers, computer 5.browsers, colour
6. .swf, .mp4

C.1.T2F3.T4F5T6.T7.T

D. 1.Multimedia is the presentation of information through more than one
presentation medium or the combination of text, sound, pictures, animation and
video. 2.The software that is used to display information in the form of a slide show
is called presentation software. 3.Entertainment, Video Games, Media Player,
Engineering, etc. 4.Media Player is used for viewing movies, listening to music and
songs, while Video Games are softwares to play games. 5.In science, it is mainly
used for modeling and simulation. Experiment of Science can be explained with the
help of multimedia presentations. 6.(a)Text is the most fundamental element of any
multimedia project, while sound is recorded using a microphone, SmartSound, etc.
and added to a multimedia presentation from a variety of sources. (b)Videos are the
moving images in a multimedia project, while Animation is a group of graphics
images that contain movement. (c) Graphics are added in the form of photographs
or designs, while Sound is recorded using microphone and then added to a
multimedia project.
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Computer in Everyday Life
(Teacher Manual) Class-6 to 8

COMPUTER IN EVERYDAY LIFE CLASS-6
1. More About Computers

A.1.d2.d3.a4.c5.d
B. 1. Calculate 2. Memorize 3. Response 4. calculating device 5. Abacus
6. Electronic Numerical Integrator and Computer 7. computer 8. primary
C.1.T2.F3.T4.F5.T6.F7.F
D. 1. Abacus 2. “Computer is an electrical device------------------ into
meaningful information. 3. because it can solve our complex problemsin a
short time, and can perform task with high speed and accuracy and also
store information for future. The prehistoric man used----------------- lines
onthe cave walls. 4. A computer provides five basic benefits. 5. A professor
of Cambridge University, because he was the first person who invented
computer named Difference Engine. 6. A “Generation of computer”
means the----------------- million circuit components integrated on it. 7.
Programming language is a computer language consisting of some
instructions and commands. Machine Language, Assembly Language and
High Level Language. 8. Control Unit: this unit controls------------------
mathematical calculations and logical operations.

2. Computer Language

A.1.d2.b3.a4.d

B. 1. two 2. languages 3. assembly, language 4. instruction 5.
communication 6. programming 7. Computer
C.1.F2.T3.FA.T5.T6.T7.T

D. 1. In order to communicate with the computer user needs to have a
language that should be understood by the computer known as computer
language. 2. two types : Low Level Language and High Level Language 3.
Advantages of Machine Language: It makes fast and-------------------- only
onetype of computer. 4. Advantages of Assembly Language: It is easier to--
————————————————— of the hardware also. 5. (a) Low Level Languages are machine
codes or close to it while High Level Languages give formats close to English
language. (b) Machine Language is the lowest and most elementary level--
————————————————— language to be developed while Assembly Language is



another low level but a very important -------------- instead of 0'sand 1's like
Machine language.
3. Computer Memory

A.1.b2.b3.d4.a5.c

B. 1. Primary Memory, Secondary Memory 2. read/write 3. volatile, non-
volatile 4. Read Only Memory 5. EPROM 6. binary language 7. auxiliary 8.
location 9. Digital Versatile Disc 10. DVD

C.1.12.13.14.15.1

D. 1. Random Access Memory, which----------------- accessed randomly. 2.
ROM is a chip where-------------- cannot be erased). 3. The DVD represents
the disc(CD) technology. 4. CD-ROM---------=------- form of
text and graphics. 5. A floppy disk, or diskette, is a disk storage medium
composed of a disk of thin and flexible magnetic storage medium. 6. A hard
disk is part of a-------------- “hard disk drive”. 7. A Pen Drive is a data storage
device that includes flash memory with an integrated Universal Serial Bus
(USB) interface. 8. The Compact Disc, or CD for short, is an optical disc used
tostore digital data.

E. 1. Memory used to store a large amount----------------- any point of time.
(i) Primary Memory (ii) Secondary Memory 2. RAM is volatile in nature------

exposing. 4. Afloppy disk is used to store, transfer and carry data. A floppy
disk, or diskette, is a disk storage medium composed of a disk of thin and
flexible magnetic storage medium, sealed in a rectangular plastic carrier
lined with fabric that removes dust particles. They are read and written by
afloppy disk drive (FDD). 5. Hard disks can store anywhere from 10 to more
than 1000 gigabytes while CD-ROM is capable of storing large-----------------
----common size is 650MB (megabytes). 6. Secondary Memory can be
classified into two categories: Sequential Access Storage Devices(SASDs)
and Direct Access Storage Devices(DASDs). 7. 8Bits = 1Byte-------------------
1Yottabyte(YB) 8. Secondary memory is also called auxiliary-------------------
--transferred to primary memory.
4. More About Windows

A.1l.c2.b3.c
B. 1. hardware 2.icon 3. Settings 4. My Documents 5. Restore all items
C. 1. Operating System (OS) is a system------------------ the hardware of
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computer. Operating System performs lots------------------ operations of a
computer system. 2. Windows operating systems, the Microsoft Desktop--

----------- contains the file that you have sent there. Click on Empty the

Recycle Bin. This option deletes all---------------- file will be deleted from the
Recycle Bin.

5. Programming With Logo
A.1.d2.c3.b
B. 1. procedure 2. blank spaces 3. END 4. “TO” 5. mass storage device 6. sub
procedure
C.1.F2.F3.T4.F5.T
D. 1. ALOGO procedure is a set of perform one main task.
A procedure is divided into three parts: (i) Title Line (ii) Body (iii) End Line 2.
There are few rules which are-------------- 3 Rectangle, X-Y, etc. 3. The
instruction which we have given inside the
procedure. 4. In LOGO, you can use a nesting of

procedure. 5. A procedure containing another procedure is called main
procedure. It contains another procedure while sub procedure does not
contain.

Main Procedure:

TO BOX2

oS

REPEAT8[SQUARE RT 45]
END

Sub Procedure: TO SQUARE
REPEAT4(FD40 RT90)

HT

END

6. Insimple language, recursion means using avariable
named STEP.

6. More On MS-Word 2010
A.1.a2.c3.d4.b5.a
B. 1. electronic, software 2. Margins 3. snazzy 4. cropping 5. Page Layout
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6. measured 7. Landscape 8. paragraph 9. attributes, document 10.
Ctrl+Shift+

C.1.T2.F3.F4.F5.T6.T7.T8.F

D. 1.Itisawindow based electronic-------------------- Online help. 2. The crop
tool in image inserted into Word. 3. There are 3types of
formatting Character formatting (Applicable on
selected text). 4. Orientation means the direction----------------- paper is to
be printed. 5. Format the paragraph to change its appearance is known as
paragraph formatting. 6. The character formatting refers to the attributes-
characterin the document. 7. 5 types 8. Newspaper-
style columns are used whenever you have------------- also make it easy to
layout a page. 9. through Print option. Click the File tab, and----------------
print arange of pages. 10. Graphics add impact to the Word--------------------

Lines, etc.
7. More on MS-PowerPoint 2010

A.1.b2.d3.a4d.c

B. 1. PowerPoint 2010 2. graphics 3. PowerPoint 4. Tables, Charts 5.
Transition 6. 2010, presentation 7. movement

C. 1. SLIDE 2. PRESENTATION 3. CHART 4. SYMBOLS 5. ALBUM 6.
ANIMATION

D. 1. PowerPoint 2010 is a visual----------------- for creating presentation to
create, view and present--------------------- charts, videos, and much more. 2.
File Menu and Backstage View, Quick Access Toolbar, Ribbon,
Slides/Outline Pane, Status Bar, Notes Pane, View Buttons, Slide Area and
Task Pane. 3. To insert a new slide into your presentation---------------------
click the layout that you want. 4. To create a photo album
---------- album slide show will be created. 5. Animation in PowerPoint is a
great way------------------ or meeting more exciting. 6. Select the object you
want Animation Pane and click Effect Option. 7.
Title Slide, Title and Content, Section Header, Two Content, Blank Slide,
etc.

8. More on MS- Excel 2010

A.1.d2.d3.b4.a
B. 1. Excel, Microsoft 2. 17 billion 3. intersection 4. multiple 5. SUM

<>



6.forward 7. Print tab

C. 1. Excel is a spreadsheet program variety of
professional looking charts. 2. Creating a new Workbook----------------- tab
then click Create. 3. Opening a workbook------------------ prompted to save
the workbook. 4. Wrap text is used to display multiple lines of-----------------
your cell will be wrapped. 5. The SUM function is used to------------------- you
want Excel to add up. To multiply: Click into cell on the spreadsheet which
you want to multiply. Now, click into the Formula Bar at the top of Exceland
type the formula there. Now press the Enter key and get the answer. 6.
Subtraction in Excel: You saw that to subtract one----------------- =Numberl-
Number2 Division in Excel: Dividing one value from
=Numberl/Number2 7. Charts are useful to perform calculations on data,
pivot the data in numerous ways, and present data in a variety of
professional look. Column, Line, Pie, Bar, Area, etc. 8. Click the File tab-------
------------------ Click save.

9. Working in Flash

A.1.c2.c3.d4.d

B. 1. made up 2. frame rate 3. human 4. animations 5. animation, Internet
6. Timeline 7. 24.00 fps 8. keyframe
C.1.T2.F3.T4.T5.F6.T7.F8.T

D. 1. Animation is a series of showing the images in
sequence. 2. Although humans have-------- until the 19" century. In the
beginning, artists would to create an animated picture. It
was not until the------------------- realistic lighting and textures. 3. 5 types,

Erase Normal, Erase Fills, Erase Lines, Erase Selected Fills and Erase Inside.
4.5 types, Paint Normal, Paint Fills, Paint Behind, Paint Selection and Paint
Inside. 5. Open a new flash file your product into flash
file. 6. Open a new flash file. Now you can see a single Layer called “ Layer
1” in your timeline. Select the first frame by clicking the rectangle under
frame numberl. Press F8 to convert this image to a
your product into flash file. 7. Flash animation are used most often on the
Internet, to create online games, electronic greeting cards--------------------
orfancy navigation buttons.

10. Internet
A.1.a2.b3.c4.a

B. 1. Transfer Protocol 2. 1969 3. tremendous 4. Internet, body 5. data,
analog 6. Communication 7. URL 8. websites, programs
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C.1.T2.T3.F4.T5.F6.F7.T8.T9.T10.T

D. 1. The Internet is a massive body connected to the
Internet. 2. Internetis use as a medium to connect with

will be displayed while and TCP can be called backbone of Internet. It is a
network of networks that----------------——--- business, and government
networks. (b) A web server is a program that---------------- the hypertext
transport protocol(http) while Home Page is the document that serve as---
————————————————————— to a web of related documents. (c) File Transfer Protocol is

amethod one computer to another while URL identifies
and locates a resources can access it directly. 6. Modem
is a short form of----------=-=-=-=--- network through telephone line. 7. Web
browser is a software that provide access to www

resources. 8. with the help of equipments like Computer, Modem, Web
Browser and Telephoneline.
COMPUTER IN EVERYDAY LIFE CLASS-7
1. MS-Word 2010

A.l.c2.c3.b4.a5.a

B. 1.two, drop 2. top 3. F7 4. name, future 5. synonyms/antonyms 6. Table
Of Contents 7. watermark

C.1.F2.T3.F4.F5.F6.T7.F

D. 1. The Microsoft Office Backstage information, and
setting file options. 2. Drop Cap is a specially formatted letter that appears
at the beginning of a paragraph. 3. Select the text or item--------------- Click
Add. 4. To check spelling and grammar and grammar for
all documents. 5. Mail Merge is a very easy way for sending circulars,
information, letters, etc. to more than one person or company at a time. 6.
for sending circulars, information and letters, etc. 7. Mail Merge Wizard----
------------------- status bar will indicate multiple letters. 8. Table Of Contents
create the Table for contents in variety of styles and levels. 9. A watermark
is a picture that shows up faintly behind the text on a word document page.
10. Open a word document in that we select
Confidential watermark. Remove Watermark: ----------------- existing
watermark fromthe document.

E. 1. Drop Cap is a specially formatted----------------- beginning of a
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paragraph. 2. Footnotes and Endnotes are used in
appear atthe end of adocument. 3. Abookmarkidentifies a location or-----
———————————— using the Bookmark dialog box. 4. Mail Merge is a very easy way
to sending circulars, information, letters, etc. to more than one person or
company at a time. 5. A watermark is a picture that
duplicate document with Duplicate stamp. 6. Table Of Contents(TOC)
create the----------------- different level heading styles.
2. MS- Excel 2010

A.1.d2.b3.d4.b5.c

B. 1. 1048576, 16384 2. row, column 3. .XLSX 4. graphical 5. ROUND
function 6. INT function 7. MAX function 8. lower 9. set, values 10. Sheet
Protection

C.1.T2. F3.F4.F5F6.T7.F8T9.F10.T
D.1.d2.g3.f4.b5.a6.c7.e

E. 1. Spreadsheet is a tabular--------------- forms rows and columns. 2. Rows,
Columns, Cell, File Button, Tool Groups, etc. 3. Creating a New Workbook---

(oldest to newest and newest to oldest).Sort option--------------- oricon set.
6. Column : Emphasizes the difference between items---------- over a period
of time. 7. Functions are built-in special are known as
arguments. 8. LEN, EXACT, RIGHT, LEFT, UPPER and LOWER 9. To create
Goal Seek: Select the cell having the--------------- box along with the results.
To create Scenario: On the Data tab of the Ribbon-------------------- with the

Scenario Manager. 10. On the Changes group of Review tab----------------
including uppercase and lowercase letters.
3. PowerPoint 2010

A.1.c2.a3.b4.b5.c

B. 1. presentation 2. business, classrooms 3. placeholders 4. professional
5.animation 6. Transitions 7. File

C. 1. used to create interactive and professional looking presentations. 2.

————————————— during an onscreen presentation while a theme is a set of
layouts-----------m-mmmmmmm uniform and professional look. 5. The timing can be
setintwo --------------- Rehearsing Slide Timing. 6. There are three types of--
———————————————————— creating customized notes pages. 7. To save your slides, go
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tothe using the Save As feature.

D. 1. A collection of pages arranged in sequence that contain text and
images for presenting to an audience known as slides. 2. Animation in
PowerPoint is a great way to make or meeting more
exciting. 3. Custom Animation effect that allows------------------- objects
within aslide. 4. Slide transitions are the animation-like effects that occur--
———————————————————— during an onscreen presentation. 5. A theme is a set of
layouts----------------- uniform and professional look.

4. Computer Networking

A.1.d2.a3.a4.d

B. 1. Computer 2. networking, two 3. server 4. Analog 5. cable 6. three 7.
WAN 8. wireless

C. 1. Networking is the transmission of data----------------- channel between
two computers. By using computer networking, one may----------- saves
energy and time. 2. Advantages Equipment Sharing: Enables users to
share-------—---—-- organization that uses stand-alone PC's. 3. Servers,
Workstations, Cable, Router, etc. 4. A server is a powerful version of
desktop--------------------- network is referred server. 5. For longer distances
or when cables are not--------------- microwaves are used. 6. A device, which
is needed to------------------ signal into a digital one. 7. A router is smart
enough to pick----------------- for analternate route.

D. 1. Network Interface Card 2. Server 3. Networking Channel 4. Cable

E. 1. A Local Area Network would include networks where the---------------
several buildings close together. 2. Metropolitan Area Network are bigger
than LAN------------------ distance communication network. 3. Wide Area
Network is spread across------------------ IBM, Ford, AT&T, etc. 4. Aserverisa
powerful version of network is referred as server. 5.
A device, which is needed to translate between------------ signal into a
digital one.

5. HTML
A.1.a2.a3.a4.c5.c
B. 1. HyperText Markup Language 2. SGML ( Standard Generalized Markup
Language) 3. Container, Empty 4. slash (/) 5. <P align=center> 6. <BR> 7.
Ordered Lists 8. indented definition
C.1.F2.F3.F4.F5.F6.F7.T8.T
D. 1. The term HTML stands for------------------- for creating web documents.
2.(a) Container tag has a ------- as ending tag while Empty tag does not have



an ending tag. (b) The <P> tag tells the browser------------ displayed on the

next line and the <BR> tag is used to------------------- key on your keyboard.
(c) The <HEAD> tag is used to denote------------------ properties of the entire
page while the <TITLE> tag is used to give a contents of

the page. 3. Netscape Navigator, Internet Explorer, Mozilla Firefox, Safari,
Opera, Google Chrome, etc. 4. In an ordered list each item is automatically
numbered starting with 1 while in menu list each element is a word----------
---------- than the other lists. 5. (a) Text control tag(Container tag) :
Container tag has a starting /tag> (b) Generally,
the web browser ignores the text to be displayed. (c)
Alist within another list is called Nested List. Directory List is normally used
for ------------ names or some bills. (d) Do yourself

6. Photoshop CS5

A.1.a2.a3.c4.a5.c6.b

B. 1. raster graphics 2. hungry 3. 2D 4. pixels 5. lines, geometric 6. duplicate
7.Brush 8. three

C.1.F2.T3.F4.T5.T6.T7.T8.T

D. 1. Photoshop CS5 is an application which known as
raster graphics. 2. Bitmap images are made up of------------- what you see
on your screen while vector images are made up of many-----------------—- at

the highest quality. 3. The Brush tool paints brush strokes and Pencil tool
paints hard-edged strokes. 4. (a) the Healing Brush tool paints with a--------
---------- blemishes, etc. in a image while the Patch tool repairs
imperfection--------------- using a sample or pattern. (b) The History Brush
tool paints a copy------------ the currentimage window while the Art History
Brush tool paints with stylized------------ selected state or snapshot. (c) The
Eraser tool erases pixel and------------ previously saved state while the
Magic Eraser tool provides you with a--------------- color area very easily. (d)
The Blur tool blurs hard edges in an image while the Smudge tool smudge
data in an image. (e) The Dodge tool lighten areas in an image while the
Sponge tool changes the color saturation of an area. 5. The Pen tool allows
you to draw smooth-edged paths. 6. Layers are like transparencies stacked

on top other parts of the images. 7. Masking is the
protection of the image. Masks allow you to isolated---------------- effects to
animage. 8. There are three types------------------- shape of another layer.

E. 1. Bitmap images are made up of------------------ the images you see. 2.
Vector images are made up of many--------------- based images are
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independent. 3. The Custom Shape tool makes customized-------------
custom shape list. 4. The Text tool is one of the most-------------------- using
pre-designed formats. 5. The Gradient tool can be used to create-------------
———————— by draggingin the image. 6. Layers are like transparencies stacked on

top of----------memeee- parts of the image. 7. Adobe Photoshop CS5 and
elements allow for----------------- layer mode to screen. 8. Masking is the
protection of the image. Masks allow you to isolated---------------- effects to
animage.

7. Internet

A.1.c2.c3.d4.d5.b
B. 1. Internet 2. between, connection 3. Electronic Mail 4. web browser 5.
Dial-up Access, Dedicated or Leased Lines 6. Transmission Control
Protocol/Internet Protocol 7. Internet 8. network 9. Uniform Resource
Locator 10. HyperText Transfer Protocol
C.1.T2.F3.F4.T5.F6.F7.F8.T
D. 1. A system of global collection------------ house throughout the world. 2.
to communicate with the other computers, to receive messages or
retrieve information, to exchange information, etc. 3. The World Wide
Web is the server are known as Web Pages. 4. The
domain name refers to the name of the computer---------------------
organizations that own the site. URL is the location identifier for--------------
———————— www.msn.com and so on. 5. To get connected with the internet, the
hardware----------------- [ll. A modem. To start using Internet, the software--
-------------------- and Mosaic are needed. 6. The United States Department
of Defense mainly used for commercial purpose. 7.
Email stands for Electronic Mail to other users on
internet. 8. The acronym TCP/IP stands for each other
using TCP/IP. 9. HTTP or HyperText Transfer Protocol is the protocol----------
———————————— communication with each other. 10. Communication on the
internet material stored around the world.
11. There are two main ways to the money one can afford.
8. Adobe Flash CS5

A.1.b2.c3.c4.d5.c

B. 1. May 1996 2. 2D animation 3. Frames, Play head 4. Movie Clip, Graphic
5. 0.01, 120 6. 550, 400 7. Flash 8. Straighten, Smooth, Ink 9. Motion
Tweening and Shape 10. animation

C.1.F2.T3.F4.T5.F6.T7.F8.T



D. 1. Multimedia is simply multiple forms animation,
video, data, etc. 2. Flash began life in May 1996 to
Macromedia Flash V1.0. 3. Animation means creating timed----------------
core functions of Flash. 4. Menu bar, Play Head, Timeline Header, Timeline
Status, Layers, Frames, etc. 5. Drawing Toolbar, Oval Tool, Rectangle Tool,
PolyStar Tool, Line Tool, etc. 6. There are three types of symbols in Adobe

Flash CS5. Movie Clip Symbols are---------------- to use it in your project. 7.
Do yourself 8. Layers are similar to transparent sheets------------ organize
and manage layers.

E. 1. Multimedia is simply multiple forms--------------------- being playedin a

hail. 2. Adobe Flash Professional CS5 is an authoring tool---------------------
user interface application, etc. 3. The Timeline controls the timing-----------
----proceeds through the frames. 4. Panel is used to change

---itaround the required path.
COMPUTER IN EVERYDAY LIFE CLASS-8
1. Networking Concept

A.1.d2.a3.c4.b

B. 1. Computer 2. information 3. networking interface card 4. digital 5.
router 6. Network, connected 7. topology 8. LAN 9. Metropolitan Area
Network 10. Wide Area Network
C.1.T2.T3.T4.F5.F6.T7.T8.T9.F10.T

D. 1. Networking is the transmission of data----------------- between two
computers. 2. Advantages : Hardware Sharing--------------- that uses stand-
alone PC's. 3. Server, Work Station, Network Interface Card, Network
Operating Systems, Networking Channel 4. satellites, radio wave,
microwaves, etc. 5. Twisted wire, Co-axial cable and Fiber optic line 6. A
device, which is needed to translate signal into a digital
one. 7. Network topology is the way a network is
between workstationsina group. 8. The star topology connects everything
to one------------ go through the host. The Bus Topology, a single master
cable carries all---------------- go through the server. The ring pattern
connects the computer---------------- direction around the ring. 9. A LAN
would include network where--------- several buildings close together.
MAN are bigger than LAN but they or fiber optic cable.
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WAN is a large network--------------------- is required for connections. 10.
Network securities involves all activities that----------- set of tools to combat
them. Antivirus software packages, Secure network infrastructure,
Dedicated network security hardware and software, Virtual private
networks, etc.

E. 1. Network Interface Card 2. Server 3. Networking Channel 4. Cable 5.
Star6.Bus

2. Advanced HTML

A.1.a2.c3.b4.b5.d
B. 1. World, Consortium 2. an inline image 3. image 4. Links 5. row 6.
BORDER 7. Forms 8. submit 9. MAXLENGHT 10. <SELECT>
C.1.T2.T3.T4.T5.T6.T7.F8.F9.T10.F
D. 1. HTML (HyperText Markup Language) is the set of
Wide Web browser page. HTML is a formal recommendation by--------------
——————————— tags to describe web pages. 2. Inline Images : These types of
images are------------------- complete its downloading process. External
Images : These images neither are------------------- of the image gets
initiated. 3. Border, Space Attribute, Alt 4. The major concept of linking-----
----------------- “>Linking </A> 5. Border, Cell Spacing, Cell Padding, Column
spanning and Row Spanning 6. HTML has number of tags to create-----------
----and labels on those controls. 7. Do yourself

3. Database Management System
A.1.d2.a3.b4.c5.c
B. 1. operation 2. collection, database 3. database 4. computer- 5. Sharing
Data 6. records 7. structure 8. database
C.1.T2.T3.T4.T5.F6.F
D. 1. A database is simply------------------- is termed as database. 2. Data
Standardization, Synthesis of Information, User Flexibility, Data
Integration and Sharing Data. 3. Electronic data processing may as
Electronic Data Processing. 4. ADD, MODIFY, DELETE, APPEND, SEARCH,
SORT, CALCULATION. 5. File Creation, Adding Records, Deleting Records,
Modify a File, Selecting Records.

4. Introduction to Visual Basic

A.1.c2.b3.d4.c

B. 1.Presentation, data formatting 2. BASIC 3. DOS 4. Integrated
Development Environment 5. Label 6. Textbox 7. CommandButton 8.
statements 9. Check Box 10. Interface 11. Image 12. primary

12,



C.1.T2.T3.T4.F5.T6.T7.F8.F9.T10.T

D. 1. Visual Basic is a high level programming language evolved from the
earlier DOS version called BASIC. 2. In object oriented programming, the
programmer need to be an expert windows programmer to create
functional windows programs while in event-driven programming, the
programmer doesn't need to be an expert windows programmer. 3. Based
on event-driven model, IDE, Toolbox, Form Layout Window, Project
Window, Object Browser, Form Window, Compilation Options, etc. 4.
Visual Basic's Integrated---------- additional programs. 5. Windows, Menu
bar, Tool bar, etc. 6. Standard EXE allows the programmer to create a
standard executable program. 7. (a) Check Box: Provides the user with a
toggle choice. (b) Option Button: Used for selection as group. (c) List Box:
Allow user to add and delete items from the list. (d) Pointer: Used to select
tools already on the form. (e) Shape: Control for drawing circles,
rectangles, etc. (f) Image: Control for displaying images. 8. Toolbar
contains the icon to execute the command without using the menu bar
option. 9. The Microsoft windows------- particular message. 10. The
Properties window---------- selected controls. 11. In an event-driven-------
programruns. 12. Forms are the foundation------- inotherform.

5. Advanced Flash

A.1.b2.b3.d4.d5.d
B. 1. Macromedia 2. ShockWave Flash 3. display, outlines 4. layers 5.
graphics 6. Masking 7. Flash
C.1.T2.F3.T4.T5.F6.T7.T8.F
D. 1. Flashis a popular authoring software developed by Macromedia. 2.
Flashis used to create graphic-based-------- modem connection. 3. Click the
Add layer button at the bottom of the Timeline. Choose Insert>Layer. 4.
Masking is easy------- computer graphics. 5. Prepare the image---------
Export Movie. 6. Toimport a sound: Select File-----current movie.

6. Adobe Photoshop CS5

A.1.c2.b3.c4.d

B. 1. graphics, raster graphics 2. resolution 3. Photoshop Document 4. Joint
Photographic Experts Group 5. Graphics Interchange Format 6. Diffuse
Glow, Ocean Ripple 7. cool effect 8. Blur filters, retouching 9. three 10.
Adobe Photoshop

C.1.F2.T3.F4.T5.T6.F7.T8.T
D. 1. Photoshop is a graphics-------- raster graphics. 2. Vector images are
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resolution independent while Bitmap images are resolution dependent. 3.
We use the brush to Choose a foreground------- options bar. 4. Filters are
special effects that can be applied on an image. 5. Filters have--------- onan
image. 6. There are 110 filters in Photoshop that do many different things--
----for lighting. 7. Masks allow------------ from editing. 8. Three 9. Render
Filters--------- for lighting. 10. Open the image------- Press OK. 11. Ocean
Ripple Filters adds------- underwater while Twirl Filters------ pattern. 12. 3D
Transformis a filter used to wrap objects--------- onthefront.

E. 1. Photoshop is a graphics--------- raster graphics. 2. Masks allow-----------
-from editing. 3. Filters have--------- on an image. 4. We use the brush to
Choose a foreground------- options bar. 5. The Blur filters--------- the image.
6. Render Filters---------- for lighting. 7. Twirl Filters------ pattern. 8. 3D
Transformis a filter used to wrap objects----------- onthefront.

7. Collecting Data in Digital Form

A.1.d2.c3.d4.c

B. 1. school 2. Charged Coupled Device 3. Complementary Metal-Oxide
Semiconductor 4. store image 5. 24 bit 6. TIFF stands 7. Fotoman, digital 8.
PSD 9. MBL 10. Editing

C.1.F2.T3.F4.T5.F6.T7.T8.T9.T10.T

digital photos. 4. Three 5. Fotoman is a straightforward windows program
for transferring digital images to computer. 6. (a) JPEG: The JPEG format----
-web. (b) TIFF: This format----hardware. (c) Image Sensor: Positioned in the
camera------- image gathering. (d) Image Capacity: Number of images----
mode. (e) Compression: Image compression-------- an image. (f) Interface:
A physical connection------ a computer. (g) Fotoman: It is a straightforward
windows program for transferring digital images to computer. (h) Digital
Camera: Adigital camera is------- the computer.

8. CorelDraw X6

A.1.d2.d3.b4.d

B. 1.tools, professionals 2. text, paragraph 3. effects, property 4. defines 5.
Knife, adding 6. Pressure tool, thickness 7. collection 8. Distortion, Shadow
9.ruler 10. dozens of tools for creating, objects.
C.1.T2.T3.F4.F5.T6.T7.F8.T

D. 1. GRAPHICS INTERCHANGE FORMAT 2.JOINT PHOTOGRAPHIC EXPERTS



GROUP 3.IMAGES 4. BITMAP 5. VECTOR IMAGES 6. GLASS 7. CORELDRAW
E. 1. CorelDraw offers------ pages. 2. Pick tool-------- fill properties. 3.
Selectively erase-------- editing program. 4. The artistic media tool--------
Pressure Tool-----property bar. 5. Pick tool-------- fill properties. 6. Freehand
tool, Smart Drawing tool, etc. 7. To create Transparency: Select an object---
----- anotherobject.

9. Dreamweaver CS5

A.1.b2.c3.d4.a5.d6.b

B. 1. Code view, Design view, Split view 2. Rectangle, Polygon Hotspot
3. Cascading Style Sheet 4. Webpage 5. Allows 6. Image map 7. Forms 8.
Library 9. powerful 10,12

C.1.T2.F3.T4A.T5.T6.T7.T8.T9.F10.T

D. 1. Adobe Dreamweaver is a professional------------------ as avisual editing
environment. 2. Adobe Dreamweaver is a program that-------- ActionScript,
and JavaScript. 3. Features of Dreamweaver---------------- Web Standard
Support. 4. Code view: A hand-coding environment for---------------- from
the Document toolbar. 5. Select a paragraph format------------------- will be
restored to default. 6. Forms are used in web pages---------------------
Dreamweaver using the form objects. A frameset is an HTML file that
defines the layout and properties of a set of frames, including the number
of frames, the size and placement of the frames, and the URL of the page
that initially appears in each frame. The frameset file itself doesn't contain
HTML content that displays in a browser, except in the no frames section;
the frameset file simply provides information to the browser about how a
set of frames should look and what documents should appear in them. 7.
Do yourself 8. CSS stand for Cascading Style Sheet------------------ onceina
CSS document. 9. Text: A text filled element is used
must contain different field values. 10. Library is a list of page elements

that--------------—-—-—- site optionin the Assets panel.
E. 1. A hand-coding environment for from the
Document tab. 2. A design environment for visual----------------—--- button

from the Document tab. 3. When the Document window has-----------------
Split button from the Document toolbar. 4. Am image map is an electronic

image---------------- should have a unique name. 5. Links are the computer
code that connects------------------ inatable, layeror frame. 6. Libraryis alist
of page--------------- and wherever you want. 7. Forms are used in web
pages--------------- Dreamweaver using the form objects. 8. Tables are a
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powerful tool for------------ insertion point is in the table. 9. The main
message of most----------- pages and get your message across. 10. CSS
stands for Cascading Style Sheet. Cascading style sheets are---------------
across several pages at once.

F. Doyourself.

G. Doyourself.

H. Doyourself

10. Surfing Internet

A.1.b2.b3.b4.b
B. 1. Internet 2. Documents 3. Web Pages 4. HTML 5. Multimedia 6.
Connection, Network 7. Web Pages 8. classify, tools 9. computer 10.

hyperlinks

C.1.T2.T3.F4.T5.T6.F7.T8.T9.F10.T

D. 1. Internet is a necessity------------------- fir International Network. When
millions of networks----------------- are called web sites. 2. The World Wide
Web is a network major component of the web. 3. HTML
is a language which is mainly used to create web documents. HTML allows
the creation of hyperlinks------------- control over text formatting. 4. HTML
can be used to display any document hyperlinks

to other documents. 5. Multimedia is a term that was
such as the encyclopedia. 6. Real-time communications (RTC) is any mode-
----------- the source and the destination. 7. Photoshop, Director, Premiere,
Sound Edit, Flash, Front-page, Alias/Wave front. 8. Go to
http://www.blogger.com. profile and begin posting.
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